S outh B ay A pple MUG

Macintosh
August-September 2012

A"Monthly"CUPFUL"for"South"Bay"Apple"Mac"User"Group"Members"

Answering Questions about
Sandboxing

!

by Rich Mogull, TidBits, June 25 ,2012
edited for space by Pete Myers & P Townsend
Apple is in the midst of a major transition with the Mac
platform. As users flock to the Mac, it's only natural that
criminals will follow - that growing market share makes the
Mac community a sufficiently lucrative target. But it's clear
Apple recognizes this risk. Taking lessons from the currently
malware-free world of iOS, Apple has been enhancing the
security of Mac OS X since the release of Mac OS X 10.5
Leopard, slowly at first, and more significantly of late.
Apple's strategy relies on five technical pillars: enhancing
the foundational security of Mac OS X; hardening Safari
(Web browsers being the most common avenue of attack
today); encouraging apps to use sandboxing techniques to
limit attack vectors; keeping the Mac App Store as free of
malicious applications as possible; and, with 10.8 Mountain
Lion, using Gatekeeper to reduce the ability of attackers to
trick users into running downloaded malicious applications.
But we shouldn't think of this as just an ever escalating
technical battle. Apple's real goal with these changes,
especially with the combination of the Mac App Store,
sandboxing, and Gatekeeper, is to disrupt the economics
that keep the bad guys in business, rather than fighting a
never ending series of one-off skirmishes.
As Uncle Ben said, “With great power comes great
responsibility.” Apple's moves toward a more-controlled (by
Apple) experience on Mac OS X scare some users, and
they could be problematic for many developers. The
challenge for Cupertino will be to strike, and maintain, the
right balance between control and freedom. That is, if they
want to maintain the innovative heart that has made the
Mac so appealing since 1984.
Let's take a look at sandboxing, the Mac App Store*, and
Gatekeeper in particular, since they offer both the most
promise for preventing attacks and the most risk for the soul
of the Macintosh. (Note- see full article online for discussion of
Gatekeeper and the Mac App store, http://tidbits.com/article/13071

What is sandboxing? -- Practically speaking,
sandboxing
prevents
applications
from
doing
unexpected things to your computer. Sandboxing
encompasses a set of techniques to isolate applications
and minimize what they can do on your Mac. The idea
is that some applications could harm your computer,
either deliberately or if an attacker compromises them,
and putting these apps in a “sandbox” limits the
potential damage. A sandboxed application is allowed
to interact with the rest of your computer only through a
strict set of rules that specify what actions it can
perform. Sandboxing has been around for a long time
and is already in use in Mac OS X, Windows, and other
operating systems.
Here's a simplified explanation of how it works. A
normal, non-sandboxed application has full access to
everything on your computer, which can include reading
and writing files anywhere on the file system, sniffing
and sending network traffic, watching everything you
type, controlling your camera and microphone, and
more. Even if an app isn't programmed to use all those
capabilities, there is nothing in the operating system to
limit what it can do. Thus, one of the most common
ways to attack a computer is to find an application with
a vulnerability, exploit that vulnerability to inject
malicious code into the application, and then use the
application to run the malicious code to perform further
actions. Continued on page 7
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Welcome to the SBAMUG
South Bay Apple Mac User Group

Meetings: Lomita Veteran’s Hall,
1865 Lomita Blvd, Lomita
Mail: PO Box 432, Redondo Beach, CA
90277-0432
Phone: (310) 644-3315
Email: info@sbamug.com
Website: http://www.sbamug.com

Members, friends and
colleagues are invited
to attend our monthly
meetings. The $35
annual membership
dues entitle you to
receive this monthly
newsletter by mail or
online, plus many
more benefits (page
8).
To become a
member or get more
info please check our
website.

Lomita Veteran’s Hall,
1865 Lomita Blvd, Lomita

SBAMUG Monthly Calendar –
August 29 - IOS Devices (iPad, iPhone):
A Panel of SBAMUG members talk about using these devices

September 26 - Mountain Lion
***Read this newsletter online (active hyperlinks!) at http://www.sbamug.com/newsletter.html ***
Other Meetings:

SBAMUG Meeting Format:
6:30—7:30 p.m. Questions & Answers and Sharing:
Everyone is welcome, beginners encouraged
7:30—7:45 p.m. ‘iSocial’ – shoot the Mac breeze
with others over a cookie
7:50—9:00 p.m. Announcements and iProgram
**Refreshments provided; donations appreciated!
Submit suggestions for topics or speakers, or articles, ideas &
original artwork for this newsletter by the last Wednesday of
each month. Articles may be edited to fit space. Submit to:
ptownsend@sbamug.com

Officers & Volunteers:
President: Arnold Silver
VP: Bob Goodman
Secretary: Wayne Inman
Treasurer: CW Mitchell
Directors at Large: Dave Nathanson, Margaret Wehbi,
Pam Townsend, LJ Palmer
PD Disk Editor: Jim Pernal Membership: CW Mitchell
Programming: Bob Goodman
Greeter: Vacant
Server Director: Dave Nathanson
Newsletter: Pam Townsend, Pete Myers, Bill Berks
USPS Liaison: Don Myers
Refreshments: The Crab Apples

st

• 1 Sat. Core Group 10 a.m. – Location variable. Ask at
the meetings or email: info@sbamug.com
• Special interest groups (SIGs): Ask at the meetings or
email: info@sbamug.com
• Last Sat.- Northrop Grumman-Ham Radio & Computer
Swap Meet, 7--11:30 a.m. Meet at SE corner of
Marine/Aviation Blvd, Redondo Beach
• Los Angeles Portable Users Group: Mac OS X, iPhone,
iPod, MacBook, etc., http://www.lapug.org/
• Find more http://www.apple.com/usergroups/

Membership Report –134 members
Please wear your membership card as your
name tag at our monthly meetings.
Thank You Member Renewals: S/MSgt. Samuel Peters,

Hyim Levy, Cleve Hildebrand.
Contact Membership Chair CW Mitchell for any corrections:
cwmitchell@sbamug.com. Renew at the meetings or by mail.

THE SOUTH BAY MUG (ISSN 1058-7810) is published monthly for $35 per year by South Bay Apple Mac User Group, 2550 Via Tejon, Suite 3J,
Palos Verdes Estates, CA 90274. Periodicals postage paid at Palos Verdes Peninsula, CA and at additional mailing offices. POSTMASTER:
Send address changes to THE SOUTH BAY MUG, P.O. Box 432, Redondo Beach, CA 90277-0432.
The South Bay MUG is published by the non-profit South Bay Apple Mac User Group. Excerpts may be reprinted by user groups and other non-profit media. Credit
must be given to SBAMUG and the author. In addition, a copy of all reprinted materials must be sent to us at the above address. The South Bay MUG is an
independent publication not affiliated or otherwise associated with or sponsored or sanctioned by Apple® Computer, Inc. The opinions, statements, positions and
views stated herein are those of the author(s) or publisher and are not intended to be the opinions, statements, positions or views of Apple® Computer, Inc.
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PD-CD JIM PERNAL
AUGUST 2012 PUBLIC DOMAIN CD
Nine items this month. I’m noticing that programs such as
the Adium one below, will list earlier versions that can run
on older versions of Mac OS X. While this is convenient, it
also means the developer is no longer planning to support
earlier versions of OS X.
Acorn-4.zip Bitmap image editor. New trim out select
feature added. Has image filters and works with layers. OSX
10.6.6 or better Intel only Shareware $49.95
Adium_1.5.2.dmg King of free instant message clients.
Handles AIM, ICQ, MSN Yahoo, Google Talk, Novell and
others. Bug fixes in this version. OSX 10.6.8 Intel only.
CocktailMLE.dmg Cocktail Mountain Lion edition. Latest
utility to clean, repair, and optimize your OSX 10.8 operating
system. $14.00
MacGourmet-3.2.4.zip Dynamic recipe manager. Create and
edit recipes. MobileMe support since it has gone away is
deleted in this version. OSX 10.8 support added. OSX 10.6
or better Intel Shareware $29.00
Mactracker_6.5.zip Database of all mac model
specifications along with printers, keyboards, iPods, cameras,
printers. Scanners, you name it as long as it was an Apple
product. Latest new Macs added to this version. PPC/Intel
OSX 10.5.4 or better. Free
NoiseMachine.dmg White noise generator to block out
workspace noise. OSX 10.6 up to 10.8. Intel only. Shareware
$4.95
Pacifist_3.0.6.zip Utility program to extract just one or a
few programs out of a full up installer package. Just grab that
file you or someone else deleted. OSX 10.4.11 or better
PPC/Intel. Shareware $20.00
PXC1.3.zip Pixel Check. A checker program for LCD’s
with bad pixels, You can have it turn on all red, blue, green,
all black or all white pixels to see if you have issues. OSX
10.7 or better. Freeware.
SyncFoldersFree.dmg Sync contents of folders. Easy
backup to USB or remote drives. Free as in the title. OSX
10.7
CD for this month will be at the August 2012 meeting,
labeled as the July-August CD. I’ll see you at the August
meeting.
Jim Pernal, PD Editor

App of the Month
This comes by way of the email group.
One of the members writes, I'm looking for a
simple text-editor/word-processor for the iPad. I
have "Notes" and it's OK. Pages seems like
overkill and I don't have iCloud on my iMac.
And the text-editor must not require the Internet.
Another email group member responds:
SimpleNote is free, and has a web interface:
http://simplenoteapp.com
Notational Velocity also provides the ability to
write with a stylus: http://notational.net;
http://itunes.apple.com/us/app/notability-takenotes-annotate/id360593530?mt=8

How does the SBAMUG use your
annual dues?
Rent for the meeting place, newsletter printing &
mailing, hardware & software, PO box rental, etc.
We save a lot through volunteers.
Sparked by the Email Group, the August Core
Group discussed the future use of dues and
possible adjustment.
The Core Group decided to maintain the $35
annual dues (a bargain really!) to ensure financial
stability. We focused on meeting, presentation and
communication needs. Things like moving club info
to the cloud (instead of buying a new or upgraded
computer), hardware and software to support
presentations, and hardware so our equipment can
communicate. We also talked about Meetup Group
as a way to get new members.
The Core Group noted that members versus
meeting attendance (around 3:1 or 4:1) means the
value of the club for those who seldom attend must
be the newsletter and Email Group.
Another need is updating and enlivening the
SBAMUG website. A great volunteer opportunity
to learn and create.
Attend the next Core Group. It’s really quite
rousing.
Subscribe to the email group by sending an email
to everybody-on@sbamug.com)
P. Townsend, Editor
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Mac 911
by Christopher Breen, Macworld
Locating and dispensing with old applications
Reader Chas Hamilton has come down with a case of
spring-cleaning fever. He writes:
I was just looking at my Applications folder that contains
hundreds of apps and realized that there are a lot of old
things in there that I never used. I came up with the clever
idea to sort my applications by the date they were last
opened so that I could toss out old apps. (I figured that if I
hadn’t touched something in the last two years I wasn’t
likely to.) I’m running Snow Leopard and the problem is that
when I open my Applications folder and choose View ->
View Options, the option to view files by Last Opened is
grayed out. Is there some way to make it active?
You’re correct, Apple disabled that option in Snow Leopard.
I’ve attempted to edit the com.apple.finder.plist file in order
to make it active with no luck (though you can edit this file to
enable other view options).
Open the Applications folder and then press Command-F.
In the resulting search window click on Applications at the
top of the window so that you’re searching that folder.
Configure the pop-up menus at the top of the window to
read Last Opened Date is Before X/X/2010 (a data
approximately two years ago). Click the Plus button to
create another condition. Configure this one to read Kind is
Application. (You do this because your Applications folder
may contain files that haven’t been opened in the last two
years.)
The list below should contain only those applications that
you haven’t opened in the last two years. If you don’t see a
Last Opened column in this window, press Command-J to
bring up the view options window and enable the Last
Opened option (which, in this case, does work). With this
column visible you can then sort the list by date, making it
easy to locate those applications that you really, really
haven’t used lately.

I wouldn’t bother trying to learn what that specific
ˆ8003 error means. The Mac can throw up all kinds of
error codes and very few of them make sense (or have
much published about them). Instead, just assume
something’s mucked up and go from there.
We’ll start with general muckage. Launch Disk Utility
(/Applications/ Utilities), select your startup drive in the
left side of the window, click the First Aid tab, and click
Verify Disk. Disk Utility will perform a check of your
startup volume looking for any obvious errors. If it finds
any errors, boot from another volume (in Lion this can
be the Recovery HD partition, in earlier versions of the
Mac OS, boot from the latest OS X installer disc).
Again, run Disk Utility from this new volume, select
your regular startup volume, and click Repair Disk.
With luck, everything will be repaired, you’ll return to
your startup drive, and be able to empty the trash.
Without that luck, you may have to turn to a sterner
utility such as Alsofts' $100 Disk Warrior.
You say that Disk Utility found no problems yet you still
can’t empty the trash. If you like pushing buttons,
return to Disk Utility, select your startup volume,
choose First Aid, and click the Repair Permissions
button. Any luck? I thought not.
If you’re at the end of your rope in a “For cryin‚ out
loud, Chris, just tell me how to empty the dratted trash
already because I'm pretty sure this is a case of a
corrupt file” kind of way, okay, here’s the answer.
Download a utility that ignores OS X’s objections and
takes out the trash like you asked it to. There are a
variety of these tools – all of which plaster a nice GUI
on Unix commands. The one I prefer is Titanium
Software’s Onyx. It’s free and it works. What more
could you ask for?
Launch Onyx and allow it to run a couple of tests on
your drive. Once those tests come up negative select
the Utilities tab, click the Trash tab in the window, and
make sure that the Delete option is selected. Click on
Execute and Onyx should go where the Mac OS
refused to and empty the trash.

Naturally, before tossing out these less- favored
applications you’ll want to examine them carefully so that
you don’t discard something that you anticipate needing
some day. Note that if you’re running Lion, this isn’t an
issue as Date Last Opened is enabled in view options.

Just to be sure that the problem’s root isn’t deeper
down in the system, quit Onyx, toss a file you don’t
need in the trash, and empty the trash. If it flushes as
expected you should be good to go.

Empty the #$&@! trash already!

Remotely
iPhone

Reader Jim Young has a trash that’s starting to stink up the
place. He writes:
I found that I was running out of space on my hard drive so I
located some large files and tossed them in the trash. But
when I tried to empty the trash I received a warning
indicating that the trash couldn’t be emptied because of a
ˆ8003 error. I really need to empty the trash but it won’t
respond. What can I do?

transfer

iPhoto

images

to

Reader Robert Zavod would like greater access to his
photos from his iPhone. He writes:
When using my iPhone on the road, I’d like to access
my iMac and its iPhoto library and move some of the
images in that library to my iPhone. Is there a way to
do that?
Continued on page 5
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Rumors & Stuff
by Phil Russell, CMUG
When you are moving an iPad app from screen
to screen, do you get a blurry snap back with the
app staying in place? The approved way of
moving an app is to drag the app JUST to the
edge of the screen and hold it there. The next
screen will appear and you can continue the drag.
I told you about this long ago, but it is worth
repeating. If you want a longer note than
convenient to put into an item's title text, use
Spotlight Comments. Plenty of room there for a lot
of text. To do this, highlight the item and press
Command + I (Get Info under the File menu) and
type your text under Spotlight Comments.
Try the iPad Academy for iPad
hints, <http://ipadacademy.com/ category/ipadtips-tutorials>
There is a red line in the iPad's scrubber bar
indicating how far into a song you are. You can
drag that line to skip to any location in the song.
As you drag slide your finger downward on the
screen, the scrub rate slows down.
To send SMS-like messages in iPad:
• In Settings select Messages
• Turn iMessage ON.
• In Receive At enter your Apple ID and your
email address or addresses.
• To send a message, open the Messages app
icon, enter a name of a contact after To:.
• Contacts will appear as you type.
If you cannot send the message to a contact using
this email address, the contact will appear against
a red background with an exclamation mark at the
end. Type Subject where it says Subject.
Your message will be typed on the very next text
space just below the Subject line. Tap the camera
to add a photo to the message.
When you failed to bookmark a site on your
iPad, you can get to it using History. To do this in
Safari tap the Bookmarks icon (looks like an open
book). Under Bookmarks tap History and select
the site you want from the list which appears.
You can make sites you visit frequently in Safari
have special privileges. These are called web
clips. To add a site you visit often, go to that site
and select Add to Home Screen instead of Add
Bookmark. The result is an icon which appears
among your app icons. Of course you can also
add a bookmark if you wish. Cont’d on page 6

Mac 911, continued from page 4
Yes. There are a couple of ways to approach this. The first is
the dead-simple way (recently suggested to me by reader
@snaab via Twitter) and the second is my original method,
which can be more broadly helpful for communicating
remotely with your Mac but is more complicated. We’ll start
with the simple solution.
On your iPhone download a copy of Tunaverse Media’s free
Blinq Photo app. On your Mac, travel to Tunaverse’s website
and grab an equally-free copy of Blinq for Mac. Fire up the
Mac client and create an account (this requires that you
create a username and password and enter an email
address). Once your account has been created you’ll be
asked whether you’d like Blinq to use your iPhoto or Aperture
library. Choose iPhoto.
Now shift over to your iPhone, launch the Blinq app, and log
in with the account you just created. In a short while, your
Mac will appear as one of Blinq’s photo sources. Tap on the
computer icon to view your iPhoto albums. Tap an album or
event, select an image, and from the Action menu at the
bottom-right of the screen choose Save to Photos App. The
image is then copied from your iPhoto library to your iPhone.
Regrettably you can choose to copy only one image at a time.
Now for the more complicated way.
That more complicated way is a two-step conundrum. The
first is that you must find a way to access your iMac. The
second is moving the images you want to your iPhone. We’ll
take them in order.
Although it really should go without saying, for this to work
your iMac must be run- ning. Also, you must have an iCloud
account and the latest version of iPhoto. You additionally
must select iCloud in Settings on your iPhone and enable
Photo Stream.
Now that we have that straightened out, you’ll next need an
iOS app that allows you to connect to and control your Mac
remotely. There are a variety of these apps. I’ve used
Edovia’s $20 Screens VNC, the $20 iTeleport for iPad, and
the $3 Splashtop Remote Desktop for iPad and each can do
the job, both on the same local network as your computer and
from across the Internet.
What these apps do is show you your iMac’s screen on your
iOS device. Using one gesture or another, you then navigate
that screen just as you would if you were sitting in front of the
computer.
Now that you can do that, remotely launch your copy of
iPhoto on your iMac. Navigate to the images that you’d like to
eventually see on your iPhone and select them. Move to the
Share menu and choose Photo Stream. The images you
selected will be uploaded to iCloud’s Photo Stream.
All you have to do now is wait for iCloud to work its magic.
Eventually the images you selected in iPhoto will appear in
the Photos app on your iOS device within its Photo Stream
album.
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Rumors, continued from page 5
Learn how to compress an image to create a small file for
uploading to a web site or sending via email. You can use
iPhoto’s export function for this. Go to Export under the File
menu and you find this, fig. 01, and choose quality and size.

A fascinating page of links to Mac videos can be
found at <http://macmost.com/video-list>. There are
more than 600 videos shown. Each keyword category
contains 3 to 63 or more videos. Some categories are
Automator, Email, Backing Up, iCal, iPad, Mail,
Podcasting and 45 more categories.
Do you want to learn how to wrap text in Pages
around an unusual shape? Go to
<http://macmost.com/wrapping-text-around-customshapes-in-pages.html>. Gary Rosenzwein of
MacMost will explain how in four and a half minutes of
video.
The “Rule of Thirds” one of the first things that
budding digital photographers learn about in classes
on photography and rightly so as it is the basis for well
balanced and interesting shots. However that rules
are meant to be broken and ignoring the rule of thirds
doesn’t mean your images are necessarily
unbalanced or uninteresting. But if you intend to break
a rule you should always learn it first to make sure
your breaking of it is all the more effective!

Fig. 01. Exporting an image
If the image is not in your iPhoto library, then you can also
use Preview to create a compressed version without buying
any new software. Go to the Tools menu to do this, fig. 02.

The basic principle behind the rule of thirds is to
imagine breaking an image down into thirds (both
horizontally and vertically) so that you have 9 parts,
fig. 03.

Fig 03. Rule of Thirds

Fig. 02. Adjusting Size

You can see how the rule of thirds works on an iPad.
Click Camera. Now under the Options button and
select Grid ON (only available when in back picture
mode - taking photos away from your face). Once the
Grid is ON, the rule of thirds lines will appear in both
back and front facing modes.

Are you looking for a simple way to take pictures on an
iPhone and upload them to one of the major photo sharing
services, without much hassle? The official Flickr app does
that. It makes it simple to upload pictures from a camera roll
directly from an iPhone to Flickr.

With this grid in mind the ‘rule of thirds’ now identifies
four important parts of the image that you should
consider placing points of interest in as you frame
your image.

If the owner of a Mac account is incapacitated or is
otherwise not available, you can get into the account using
an Apple Software Restore disc (included with newer Macs)
or a Mac OS X Install disc. Complete instructions are
available at <http://kb.wisc.edu/page.php?id=3853>.

The theory is that if you place points of interest in the
intersections or along the lines, then your photo
becomes more balanced and will enable a viewer of
the image to interact with it more naturally, fig. 04.
Continued on page 7
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Sanboxing, continued from page 1

Rumors, continued from page 6

In contrast, a sandboxed application doesn't run with full access.
Instead, it executes inside a restricted container that is isolated
from the rest of your Mac. Thus, if an attacker were to exploit a
vulnerability in the app and inject malicious code, that code
would be limited to the sandbox.
That might work for simple, standalone apps like casual games Angry Birds could be sandboxed easily. But for more complex
programs, sandboxing has some obvious problems, like saving
files and accessing the network. To work around this problem,
each individual application can be given a set of “entitlements”
that allow the app limited access to other parts of your Mac.
For example, a fully sandboxed app with no entitlements can
save files only into its own directory, but with an entitlement, it
can be given permission to save files anywhere in your home
folder (which is still safer than the app being able to save a file
anywhere on the file system). iOS apps are heavily sandboxed,
which is why apps can't access each other's files. iOS offers no
entitlement to access shared files other than photos, so we're
forced to copy files from app to app using the Open In command.
This particular limitation in iOS, to be blunt, sacrifices usability for
security. But at least most apps in iOS don't create or manipulate
documents (although that's changing, thanks to the iPad). On the
Mac, where far more applications are document-centric, and
where the entire user experience revolves around the Finder,
such a system would be a major disaster that would immediately
drive every professional user to Windows. It would become
impossible to use multiple apps to make changes to the same
document without making a vast number of copies, and keeping
track of which change was in which copy would be a nightmare.
As a result, Apple has created more possible entitlements for
Mac apps than for iOS apps, but sandboxed apps are still far
more restricted than their non-sandboxed brethren.
The overall goal is the same - to ensure an application can't do
too much damage to your system, either by design or ifR it's
compromised by an attacker. But since the needs of Mac users
u
are different than the needs of iOS users, it's hard to figuremout
the right balance of restrictions and entitlements.
o

r

Why is sandboxing so important? -- As operating systems
s
have become harder to exploit, attackers have started targeting
,
specific applications. We see more attacks against Adobe
Acrobat and Flash, Microsoft Office, Java, Web browsers, and
c
QuickTime than we do against Mac OS X and Windows
o
themselves. That's why, for example, Apple now sandboxes
parts of Safari and QuickTime, Google sandboxes Chrome,nand
Adobe sandboxes Reader and Acrobat (only on Windows). t

i

Take Google Chrome. It is widely considered the most secure
n
Web browser available, due to its heavy use of sandboxing.
u
Chrome even embeds and sandboxes its own version of Adobe
e
Flash to reduce the chance of a Flash exploit taking over a
computer. That’s why I uninstalled Flash from my Mac and dview
Flash-using sites exclusively with Chrome.

f
r
o
m
p

Fig. 04 Grid
Studies have shown that when viewing
images that people’s eyes usually go to one
of the intersection points most naturally
rather than the center of the shot – using the
rule of thirds works with this natural way of
viewing an image rather than working
against it.

Sandboxing
isn't
a
panacea.
Some
entitlements may allow an attacker to do bad
things outside the sandbox. Also, sandboxes
themselves are software and may be cracked.
But, at a minimum, the sandbox adds yet
another layer an attacker has to get past
before getting a foothold on your Mac, even if
the application inside is vulnerable and
exploited.
To put it bluntly, based on the nature of
attacks today, sandboxing is likely the future
on every computing platform.
As of 1 June 2012, all new apps and major
updates in the Mac App Store must be
sandboxed. Is there a downside to mandating
sandboxing? -- Absolutely. Not every
application can meet the sandboxing
requirements.
How does restricting where my apps come
from improve security? -- Most users never
change the defaults on their Macs. Limiting
which applications can launch to those that
come from the Mac App Store means you're
getting only apps that are vetted by Apple.
Many of those are also sandboxed; eventually
all will be. But not all programs can meet the
Mac App Store's sandboxing requirements.
###
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SOUTH BAY APPLE MAC USER GROUP
P.O. BOX 432
REDONDO BEACH
CA 90277-0432

Join, Renew or Give
a Gift of a SBAMUG
Membership!

South Bay Apple Macintosh User Group provides you with a local source of shared
knowledge & experience through monthly meetings, trainings & monthly newsletter.

For only $35/year you get:

Individual & family membership: $35/year payable to SBAMUG

•
•
•
•
•
•
•
•
•

Monthly meeting program
E-mail group help
Monthly newsletter
Use our Wiki
Free web space & e-mail on
our server
Build your own website
Create your own blog
Special merchant discounts
$$$
Occasional swaps, free
software, raffles

http://www.sbamug.com/join.html
Or, contact Membership Chair
CW Mitchell at
cwmitchell@sbamug.com

SBAMUG Membership Application

! New Member

! Member Renewal

Name:_______________________________________________________
Address:_____________________________________________________
City:__________________________ State:______ Zip:________________
Phone: (________)____________________________________
Email Address:________________________________________________
Special interest:_______________________________________________
Model of Macintosh you use most:_________________________________
How did you hear about SBAMUG:________________________________
Comments:___________________________________________________
____________________________________________________________

Signature:_______________________________________________
Date: __________________________
Bring your Application and Fee to our General Meeting or Mail to:
SBAMUG, PO Box 432, Redondo Beach, CA 90277-0432
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